
        Exit

Use this command to leave Pro One Book Report and return to Windows.    
Exit can be found directly on the toolbar, or by clicking on File to use the File 
Menu.

If the current book report or outline needs to be saved, a pop-up will provide 
a warning and a chance to do so before you exit from the program.



Save As

Use this feature of the File Menu to save the current book report and/or 
outline under a different name.    A pop-up will then prompt you to type in the
new name.

          

User's Tip:    Unless you specify otherwise, the standard file extension will 
be .BRP.    For ease of use, the book report and its outline are saved together 
in a single file.



Save

Use this feature of the File Menu to save the current book report and/or 
outline.

If you've saved this book report before, it will be updated under the existing 
name.    If you haven't saved this book report, you'll be prompted to assign it 
a name before it is saved.



Open

Use this feature of the File Menu to open an existing book report and/or 
outline.    When you do, a pop-up will prompt you to select a book report.    
Simply click on the one that you want to use, then on OK, and you'll be ready
to go to work.

          

User's Tip:    Unless you're specified otherwise, all of your book reports are 
stored with a .BRP extension.



New

Use this feature of the File Menu when you're ready to create a new book 
report and/or outline.

If the previous book report was edited but not saved, you will be warned and 
you will have the option to save your changes before you lose any important 
information.



Help About
Click here to see the Help Menu's About Box and learn more about Pro One 
Book Report.



Help on Help

Click on this Help Menu option to get information about how to use the Help 
system.



        Search
Clicking on the binoculars will start a search for a specific piece of text.    
Clicking on the binoculars with the blue '+' will search again for the same 
text you searched for before.



        File Menu
The File Menu provides all of the features necessary to create, update, and 
save outlines and book reports.    In addition, you can use it to exit from Pro 
One Book Report and return to your other activities.

Click on File and you'll see a pull-down featuring the following commands:

To learn more about any of these File features, simply click on it, now.



        Idea Bank
Use this toolbar command to access a variety of idea-generating tools 
designed to help make writing your book report even easier.

After you click on Ideas, you'll be prompted to choose among the following 
useful options:

For more information, click on any of these features to see its Help, now.



        Help Menu
Use this toolbar option to learn more about how to use Pro One Book Report.  
A pull-down will prompt you with standard Windows Help features that 
provide full information on how to get the most out of this program.

To learn more now, click to see the Help listings for the options that appear 
on the Help menu:

User's Tip:    Pro One Book Report's Help feature follows standard Windows 
conventions.    So if you're experienced at using the Help in other software 
packages, you probably won't have any problems using this one, either.



        Copy

Use this to copy the selected text.    Then use Paste to place it in the new 
location in your book report.

To select text, proceed in the usual Windows fashion:    position your pointer 
at one end of the section, press down the left mouse button and drag the 
highlight until the entire section is selected.

User's Tip:    To move information, use the Cut tool instead of Copy and save 
yourself a step.    Or for more information about selecting text in Windows, 
consult your Windows User's Guide.



        Insert Page Break

Click on the Body Box's Page icon to insert or remove a page break at the 
end of the current section.    Forced page breaks can only occur at the end of 
a section.    If the page icon has a gray page with an 'x', then there will be no 
page break after this section.    If the page icon has a white page with a 
checkmark, then there will be a page break after this section.

User's Tip:    If you find that a page is printing 'funny', make sure that you 
haven't accidentally left an old page break in a place where you no longer 
need it.



        Paste

After you're used Cut or Copy to store a selected section of text in the 
Windows clipboard, use Paste to insert it back into your book report or 
outline.

User's Tip:    Since Paste works off of the Windows clipboard, you can use this 
command to add text from other Windows applications:    simply copy the 
text to the clipboard in another application, switch to Pro One Book Report, 
place the cursor at the desired insertion point and paste the text into your 
document.



        Cut                                                                                     

Use Cut (the scissors icon) to delete selected text from your book report or 
outline.    Then you can leave it deleted, or use the Paste tool to place the 
text in a new location.

To select text, proceed in the usual Windows fashion:    position your pointer 
at one end of the section, press down the left mouse button and drag the 
highlight until the entire section is selected.



        Undo

Click on the Body Box's Undo icon to reverse your most recent editing 
operation.    If there is no operation to be 'undone', a pop-up will warn you; 
otherwise, the change will be made.



        Fonts

Use this Body Box option to specify font characteristics for all or part of your 
book report.

When the pop-up appears, click to make your selections for the font, font 
size, font face (bold, italic or underline) and color.    Then click on OK to save 
your changes, or on Cancel to ignore them, when you're done.

          

User's Tips: You can also use the Body Box's Character Formats and the 
Character Colors buttons to adjust your text's appearance.



        Text Alignment

Click on the Body Box's justification options to specify your text's alignment.  
The justification that you click to choose will be applied to the selected 
(highlighted) portion of your book report.    To make another choice, simply 
click again.

The justification options include:

Left justify: To place the text flush with the left-hand margin
Center justify: To place each line of text so it is centered on the page
Right justify: To place the text flush with the right-hand margin
Double justify: To place both ends of the text flush with their margins

Feel free to experiment with the choice that suits your needs (and creative 
whims!).

User's Tips:    Left or double justify are the options most commonly used for 
the body of a book report; center justify is useful for title pages and figures.



        Character Formats
Click on the Body Box's character format options to specify how your text will
appear when it's printed.    The characteristic(s) that you click to choose will 
be applied to the selected (highlighted) portion of your book report.    To 
change your selections, simply click on the tools again.

The character formats include:

Bold: To print text in bold face
Italic: To italicize text
Underline: To underline text

Any combination of these three formats can be applied to any selected 
portion of your book report.    The on-screen appearance of the text will 
reflect your choices, so that you can get an advance idea of how your report 
will look after it is printed.



Font Colors

                  

When the character colors pop-up appears, click on the color that you'd like 
to use for the selected text.    Then click on OK to save that choice, or on 
Cancel to ignore it.    Your specified change will be made as soon as you 
return to the document.



        Line Spacing

Click on the Body Box icon that represents your preferred line spacing:

- Single spacing
- 1 1/2 spacing
- Double spacing

The portion of text that you've selected will be set to your chosen spacing 
just as soon as you return to the document.    If further adjustments are 
needed, simply click to specify the spacing again.

User's Tips:    Double-spacing is probably the most common choice for the 
text of book reports, although long quotes or excerpts may be single-spaced.



        Insert Graphics
Use this tool of the book report Body Box to insert a graphics file directly into
the text of your book report. The process is easy:

-    Simply click on the icon, and a pop-up will prompt you to select a 
graphics file to insert.

-    Choose the file to insert, and click on OK.

         

As soon as you return to the book report, you'll see that the insertion has 
been made.

Whenever the cursor is positioned at a graphic image, a group of black dots 
(known as "handles") appear superimposed on that image.    By clicking and 
dragging on these handles, you can resize the image, or move its relative 
vertical position on the current line.

The following types of graphics files can be inserted into the text:    Windows 
Bitmap (.BMP), PC Paintbrush (.PCX), Graphics Interchange (GIF), Tag File 
Format (.TIF), TARGA (.TGA) and Windows Metafile (.WMF).



Using Text Boxes

Text boxes enable you to type in the contents of your book report or outline.   
You'll see that they are operated in standard Windows fashion:

- Use your mouse to locate the cursor and select text
- Use your keyboard to type in the document
- Use the toolbar commands that appear just above the text boxes to 

format and edit your document.

For more information on creating a book report or outline, click on the 
highlights to review the Help listings for the Magic Writer,    About Outlines 
and About Formatting; or to learn more about how to use text boxes to 
create a book report or outline, review the listings for Body Box and Outline 
Box.    If you're still having trouble using the text boxes, consult your Windows
documentation.



        Move Down Outline Section

Click on the "down arrow" button to move the highlighted outline section 
downwards.    As soon as you do, the selected text will be moved, and the 
outline's numbering will be adjusted to reflect the change.    To move the 
section again, simply repeat the operation.

User's Tip:    For more general information on creating an outline and using it 
to build your book report, click to see the Help listing for About Outlines.



        Move Up Outline Section

Click on the "up arrow" button to move the highlighted outline section 
upwards.    As soon as you do, the selected text will be moved, and the 
outline's numbering will be adjusted to reflect the change.    To move the 
section again, simply repeat the operation.

User's Tip:    For more general information on creating an outline and using it 
to build your book report, click to see the Help listing for About Outlines.



        Change Outline Name

Click on this button to make changes to the text of an outline name.    As 
soon as you do, the editing pop-up will appear and prompt you to make your 
changes. The outline will automatically be updated as soon as you're done.

User's Tip:    For more general information on creating an outline and using it 
to build your book report, click to see the Help listing for About Outlines.



        Delete Outline Section

Click on the "-" button to delete the highlighted outline section.    As soon as 
you do, the selected text will be deleted, and the outline's numbering will be 
adjusted to reflect the change.

User's Tip:    For more general information on creating an outline and using it 
to build your book report, click to see the Help listing for About Outlines.    To 
move a section of the outline, use the Move Up and Move Down (up and 
down arrow) commands or the Cut option, instead of deleting and retyping.



        Add Outline Section
Click on the "+" button to add a new section to this outline.    The next 
section will be inserted after the section that is currently highlighted.

As soon as you click to select this command, pop-up will prompt you to type 
in the text for the section that you're adding.    You don't need to add 
numbering:    Pro One Book Report does this automatically.    Once your text is
typed in, simply click on OK (to add the section) or Cancel (to ignore it) and 
you'll return to the outline.

User's Tips:    To turn a new section into a sub-section, use the Indent (right 
arrow) button.    And there's no need to worry about chancing the section's 
numbering:    it will be automatically adjusted.    For more information, click to
see the Help listing for About Outlines.



        Indent Outline Section

Click on the "right arrow" button to indent the highlighted outline section.    
As soon as you do, the selected text will be shifted right, and the outline's 
numbering will be adjusted to reflect the change.    To indent the section 
further, simply repeat the operation, or to unindent the section, simply click 
on the "left arrow" button.

User's Tip:    For more general information on creating an outline and using it 
to build your book report, click to see the Help listing for About Outlines.



        Unindent Outline Section

Click on the "left arrow" button to unindent the highlighted outline section.    
As soon as you do, the selected text will be shifted left, and the outline's 
numbering will be adjusted to reflect the change.    To unindent the section 
further, simply repeat the operation.

User's Tip:    For more general information on creating an outline and using it 
to build your book report, click to see the Help listing for About Outlines.



        Print Menu

Use this to access Pro One Book Report's printing-related tools.    Simply click on this 
toolbar command to:

To learn more about any of these features, simply click on it, now.



Page Numbers

Use this option of the Print Menu to add page numbers to your book report.    
Then, when the pop-up appears, use it to choose among the formatting and 
style selections for your page numbers.



Print Outline

Use this option of the Print Menu to print a copy of the current outline.    The 
print request will be sent directly to the printer as soon as you click to select 
this option.

User's Tips:    To double-check your printer specifications before you print 
your first outline, use the Print Menu's Print Setup command (click on the 
command to see its Help, now).



Set Margins

Use this option of the Print Menu to make changes to your book report's 
printing margins.    When the pop-up appears, simply click on the up and 
down arrows until you reach the desired dimensions.    Then click on OK to 
save the new settings and apply them to this report or outline, or choose 
Cancel to ignore them.



Print Book Report

Use this Print Menu option when you're ready to print a copy of the current 
book report.    When you do, a pop-up will appear to guide you through your 
various printing options.    Once all of your choices are made, simply click on 
OK to start printing.

User's Tip:    If you're having problems printing from Pro One Book Report, 
begin by checking to make sure that you can print at all, by trying to print 
from another Windows application.    If this doesn't work, consult your 
Windows documentation for assistance.



Print Setup

Use this option of the Print Menu to make changes to your printer selection, 
printing orientation, paper characteristics, or other printing options.    Then 
click on OK to save your updates.



        Spell Check
Use this toolbar command to check your book report for spelling and typing 
mistakes    Simply click to see the tool's options.    Then, when the pull-down 
appears, click again to specify where you'd like the spell check to be run:

The check will begin immediately.    If any suspicious words are found, the 
follow-up pop-up will appear, and prompt you to make the necessary 
changes.

Make the appropriate selection, and the check will continue.    The checker 
will notify you when it's found another suspicious word or has completed its 
run.

Click on the pop-up, now, to learn more about any of the Spell Check 
features.

User's Tip:    Don't hesitate to add words to your Custom Dictionary, 
especially proper nouns and technical terms that appear frequently in your 
work.



Clear Custom Dictionary

Use this Spell Check command to delete all of the words from your Custom 
Dictionary.    All words in the dictionary will be deleted, and you'll be free to 
start creating a Custom Dictionary again.

User's Tip: Creating a good Custom Dictionary can make spell checking more 
effective and less tedious.    So don't hesitate to add words to your dictionary,
especially proper nouns (such as your name, author's name, character name,
etc.).



Add to Custom Dictionary

Use this Spell Check command to add the highlighted word to your Custom 
Dictionary.    The suggested correction will be ignored, and the spell checker 
will continue reviewing the remainder of your book report.

User's Tip: Creating a good Custom Dictionary can make spell checking more 
effective and less tedious.    So don't hesitate to add words to your dictionary,
especially proper nouns such as character names.



Suggested Words

All of the suggested spelling corrections will appear in this box.    The current 
suggested spelling is highlighted:    to change the selection, simply click on 
any word in the box and it will appear in the Replace Box.



Replace Box

The Replace Box contains the current suggested correction.    To change it, 
either:

-    Click on any other word in the Suggestions Box; or
-    Click in the Replace Box to type in a correction of your own.



Replace With
Click on this Spell Check button to replace the checked word with the one that's 
suggested in the Replace Box.    As soon as you do, the replacement will be made and 
the spell checker will continue reviewing the remainder of your book report.



OK or Cancel
As always in Windows, click on OK to save the current changes or Cancel to 
ignore them.



Ignore Suggested Change

Choose this if you want to ignore any suggested replacements for the 
highlighted word.

User's Tip:    Don't hesitate to add words to your Custom Dictionary, 
especially proper nouns and technical terms that may appear often in your 
book report.    Doing so can make spell checking more effective and less 
tedious.



Add to Outline

Click on this button when you're finished typing in a new section and are ready to add it 
to your outline.



        Thesaurus
Use this toolbar command to add instant breadth to your vocabulary by 
accessing Pro One Book Report's handy built-in thesaurus.    Begin by 
highlighting the word you'd like to replace.    Then click on the Thesaurus 
icon.    The following pop-up will appear, providing suggested alternatives (if 
any) and the opportunity to select one.

Click on the pop-up, now, to learn more about any of the Thesaurus' features 
and how to use them.    Or simply give it a try, and you may be surprised at 
how easy it is to make your book report even more impressive.



Thesaurus Suggestions

All of the suggested alternative words will appear in this box.

The first suggested replacement is highlighted:    to change the selection, 
simply click on any word in the box and it will appear in the Replace Box.    
Then, when you've settled on a favored replacement, simply click on the 
Replace With button and the substitution will be made.



Check Outline

Use this option to spell check the outline, only.    If any suspected 
misspellings are found, a pop-up will prompt you to correct them.    A second 
pop-up will let you know when the spell check is done.



Check All Sections

Use this option to spell check the entire book report.    If any suspected 
misspellings are found, a pop-up will prompt you to correct them.    A second 
pop-up will let you know when the spell check is done.



Check Current Section

Use this option to spell check this current section of the book report, only.    If 
any suspected misspellings are found, a pop-up will prompt you to correct 
them.    A second pop-up will let you know when the spell check is done.



    Pro One Book Report Help
Click on any graphic for more information about that feature.

Main Toolbar

            

Outline Toolbar
            

Text Toolbar
            

Ruler

            

For general information, click on one of the following:
The Magic Writer
About Outlines
About Formatting



Ruler

The ruler defines the left and right print margins, paragraph indenting, and 
tab stops.    Click below for more information on these features.



Ruler Left Margin
The bottom half of the left arrow in the ruler specifies the left margin for 
printing.    You can change this position by clicking and dragging on this piece
of the arrow.

Click on Ruler for more information.



Ruler Paragraph Indent
The top half of the left arrow in the ruler specifies the paragraph indentation. 
You can change this position by clicking and dragging on this piece of the 
arrow.

If the top half of the left arrow is to the right of the bottom half, then the 
first line of the paragraph will be indented to that position.    If the top half of 
the left arrow is to the left of the bottom half, then the entire paragraph 
(except for the first line) will be indented.    This is known as a hanging 
indent.

Click on Ruler for more information.



Ruler Tab Stops
The little upside-down "T"s in the ruler specify the default tab stops.    You 
can create your own tab stops by clicking on the ruler at the location where 
you want a new tab stop.    Tab stops that you define are displayed as large 
arrows.    You can delete one of your own tab stops by clicking and dragging 
down on the arrow.    You can also move one of your tab stops by clicking and 
dragging it to another spot on the ruler.

Click on Ruler for more information.



Ruler Right Margin
The arrow at the right side of the ruler specifies the right margin for printing. 
You can change this position by clicking and dragging on this arrow.

Click on Ruler for more information.



Thesaurus Replace Now
Click here to make the replacement.    The word or phrase that you've 
searched on will be deleted from the text and the one that appears in the 
Replace Box (just below this button) will be inserted in its place.



Thesaurus Replace Box
This box contains the current choice among the alternative words identified 
by the Thesaurus.



Body Box
The Body Box contains all of the tools that you'll need to produce write the 
main portion of your book report.    In addition to being a fully functional word
processor, it enables you to move directly from an outline to a book report 
with a minimum of effort.

The Body Box appears in the lower portion of the screen, and looks like this.

If you've begun by using the Magic Writer to generate one or more sections 
of your book report, then the suggested text will appear here.    If you're 
starting from scratch, the text box will start out empty.    In either case, 
simply click in the box to begin typing.

To learn more about any of its features, simply click on it now.    Additional 
Help listings    include the Magic Writer,    About Outlines and About 
Formatting (click on the highlights to read them, now).

User's Tip:    If the Body Box doesn't appear on the screen, its because you 
haven't created or opened an outline.    Click on About Outlines for more 
information.



Outline Box
The Outline Box contains all of the tools that you'll need to create and format
an outline.    In addition, it provides automatic indenting and numbering tools 
that make setting up and editing a breeze for even the longest and most 
complicated outlines.

The Outline Box is located just under the toolbar.    The Beginning of Outline 
and End of Outline markers signify the area within which your outline will be 
created.    To get started, simply click on the "+" (add a line) icon, and a pop-
up will prompt you to create the first line of text.    Don't worry about 
numbering this (or any other) line, since the proper letter or number label 
will be added automatically based on the line's position and indenting.    To 
adjust the indentation, finish typing in the line, then use the right and left 
arrow keys to move the line one position to the left or right; any necessary 
changes in the line's numbering will be made as soon as you click.

User's Tip:    Help listings that contain more information on creating outlines 
include About Outlines, Add Outline Section, Indent Outline Section, and 
Print Outline.    Click on any of the highlighted terms to find out more about it.



Outline Text Box
Type here to create or update the text for a new outline section.    When 
you're done, click on OK to add the text or on Cancel to ignore it.

User's Tip:    Don't worry about prefacing your outline text with the correct 
number or letter reference:    Pro One Book Report will do this automatically, 
as soon as the section is added to the outline.



Help Contents
To choose from a list a major help topics, select this feature from the Help 
Menu.    Then, when the list of topics appears, simply click on the one that 
you'd like to learn more about.

Alternately, you can perform a Help Search to look for topics by keyword 
(click on the highlight now, for more information).



Help Search
Selecting this option from the Help Menu will put you into Search mode.    
Then simply follow the prompts to search for the tool or topic that you'd like 
to learn more about.

Alternately, click to see Help on Help for general information on using the 
Help system.



Writers' Terms
Confused about verisimilitude?    Can't keep straight the difference between a
simile and a metaphor?    If so, just click on this feature of the toolbar's Ideas 
command to review a glossary of writers' terms.



Topic Ideas
Use this feature of the toolbar's Ideas command to review a selection of idea-
generating book report topics.    You'll find a list of over 30 topical ideas that 
can be applied to nearly any novel or play that you might be assigned to 
write about.



About Characters
Use this feature of the toolbar's Ideas command to learn more about how to 
analyze characters.    You'll find descriptions of various character types, 
including information designed to help you to be able to analyze a novel or 
play's characterizations with the skill of an experienced reviewer.



Margin Arrows
When the margins setting pop-up appears, click on the up arrow to increase 
the size of your margin, or on the down arrow to make it smaller.    Each click 
changes the margin by 1/10 of an inch.    Then click on OK to save your new 
settings or on Cancel to ignore them, when you're done.

Click to see the Help listing for the Set Margins command for more 
information.



        Character Colors
Click on this Body Box command to make the selected text appear in color.    
When you do, a pop-up will appear and prompt you with your choice of
font colors.    Then, simply click to apply your choice to the selected portion 
of text.

User's Tip:    Don't forget that your printer and monitor must be color-capable 
in order for you to print and preview your text in anything besides black and 
white mode.    However, the fact that you have a black and white monitor 
does not prevent you from printing in color, as long as you do have a color 
printer.



OK to Exit
Click on OK to exit from the Idea Bank and return to the main Pro One Book 
Report Work Screen.



Page Numbers On/Off
Click here to turn page numbering 'on' and 'off'.    Then click on OK or Cancel 
to save or ignore this, and any other changes, that you are making.



Page Number Position
Click here to adjust your page numbers' position on the page.    Then click on 
OK or Cancel to save or ignore this, and any other changes, that you are 
making.



Page Number First Page
Click here to determine whether or not a page number appears on the first 
page. Then click on OK or Cancel to save or ignore this, and any other 
changes, that you are making.

User's Tip:    The first page will always be counted, even if no number is 
printed on it.    You'll probably want to choose this option if you've begun your
book report with a title page.



Page Number Justify
Click here to adjust your page numbers' justification.    Then click on OK or 
Cancel to save or ignore this, and any other changes, that you are making.



Page Number Style
Click here to choose the style in which your page numbers will be printed.    
Then click on OK or Cancel to save or ignore this, and any other changes, 
that you are making.

User's Tip:    Unless your instructor has told you otherwise, the choice of 
pagination styles is merely a matter of personal preference.



Page Number Font
Click here to choose a font for your page numbers.    The subsequent pop-up 
will allow you to make your choice of fonts and sizes.    (Click to see the Help 
for Fonts, for more information.)

User's Tip:    Standard technique is to use the same font as is used for the 
body of the report, at the same or a slightly smaller font size.    For example, 
if your report is being printed at a font size of 12, you'll probably want to use 
either 10 or 12 for your page numbers.



About Formatting
Use the toolbar commands that appear at the top of the Body Box to specify 
the format for your book report.    It provides a variety of formatting options 
which can be applied either to the entire book report, or to a selected book 
report section.

Begin by highlighting the part(s) of the book report to which this format will 
be applied.    Then select the types of changes you want to make, and click 
on OK when you're done.    Options include:

Font Selection
Text Alignment, to set justification
Character formats including Bold, Italic and Underline
Character colors, to view and/or print color text
Spacing

In addition, you'll see a variety of useful editing commands that allow you to 
cut, copy and paste text, add page breaks, and insert pictures into your 
document.

Click on any of the highlighted Help topics to learn more about it, now.



About Outlines
Outlines are a useful way to start a book report.    And Pro One Book Report 
makes it easy to create an outline, by providing a variety of point-and-click 
options.

If you begin your report by using the Magic Writer, an outline will 
automatically be generated based on your choice of sections.

Or to get started on your own, simply go to the Outline Box and click on the 
"+" (add a line) icon.    A pop-up will prompt you to compose the first line of 
your outline.    Repeat the process to fill in the rest of the outline, using the 
right arrow and left arrow keys to automatically set up your indenting and 
numbering.    Just that painlessly, your outline will be underway.

Pro One Book Report automatically associates a particular outline with a 
specific book report, and vice versa.    To further reduce confusion, they are 
saved as part of the same file, so that opening a book report automatically 
opens its corresponding outline.

Click on any of the highlighted terms to learn more about it, now.



Font List
Use the scroll bar to move through your list of available fonts.    Then click to 
highlight the font that is your selection, and your choice will be confirmed by 
appearing in the box at the top of the list.    Your new font will be applied as 
soon as you click on OK to return from this pop-up.



Font Effects and Color
Click in the check boxes if you'd like your text to appear with strikeout or 
underline.    You can also select a color for your text by clicking on the font 
color box.    Any color and effects that you've chosen will be applied as soon 
as you click on OK to return from this pop-up.

User's Tip: Underline can be applied to your book report even more 
conveniently by clicking on the underline button (see the Help for Character 
Formats for more information).



Font Style
Click to highlight your choice of font styles.    Your choice will be confirmed by
appearing in the box at the top of the list.    It will be applied to your book 
report as soon as you click on OK to return from this pop-up.



Font Size
Use the scroll bar to move through your list of available font sizes.    Then 
click to highlight the font that is your selection, or click in the box to type in a
size of your own.    Your new font will be applied as soon as you click on OK to
return from this pop-up.

User's Tip: Just because a font size doesn't appear on the scrollbar list 
doesn;t mean that it can't be used.    So if 13 is the perfect font size for you, 
simply type it in.



File List
Use the scroll bar to move through your list of available files.    Then click to 
highlight the name of the file that you'd like to use, and your choice will be 
confirmed by appearing in the file name box at the top of the list.    The file 
will be opened as soon as you click on OK to return from this pop-up.

User's Tips: Don't forget that the choice of file name, drives, directories and 
file formats will dictate which files appear on this list.    So if you are looking 
for a file that you can't find, use these tools to widen your search.



Directories
Use this box to define the name of the directory in which your file(s) will be 
found.    Click to highlight the name of the directory in which you'd like to 
look, and the name will appear above the box in confirmation.    All of the files
that share the format for which you;re looking will then appear in the file list 
to the left of the pop-up.



File Format
Use this to specify the file format that you'd like to use.    To see more 
choices, click on the down arrow, and the full list of available formats will 
appear.    Then simply click to make your choice, and the file list will be 
updated to reflect your selection.



Drives
Use this to specify the disk drive on which your file(s) will be found.    To see 
more choices, click on the down arrow, and the full list of available drives 
(including floppy and CD-ROM drives) will appear.    Then simply click to make
your choice, and the directories list will be updated to reflect your selection.



Preview On/Off
Click here to turn the preview feature on or off.    When preview is on a 
miniature of your selected graphics file will appear on the pop-up, and give 
you a chance to confirm your selection before it is actually inserted into your 
book report.    To preview another file, simply click on the file list to make 
another selection.



File Name
You may type in a file name here to select that file.    In addition, you may 
enter a name with wildcard characters (*, ?), and the file list below will 
display only those files in the current directory that match the file name that 
you entered.



Report Worksheet
Use this feature of the toolbar's Ideas command to preview and/or print a 
worksheet designed to help make your report-writing even easier.



      About the Magic Writer
The Magic Writer is a feature unique to Pro One Book Report.    It is designed 
to make writing faster and easier for those who are stumped -- or running up 
against a deadline -- by producing draft text for your book report based on 
your answers to a few simple questions.

The Magic Writer uses standardized text templates to generate draft text for 
17 different book report sections.    Each section represents a type of analysis
that is commonly used for book reports, such as character analysis, plot 
analysis, use of imagery, etc.    It's up to you to decide which of the sections 
to include in your report, and what order to use them in.    You can use all of 
the sections in a single report, or as few as just one (see Tip below).    The 
Outline Box will indicate what sections you've already selected and what 
order they will appear in.    If you aren't happy with the standard order, 
simply use the box's tools to reorganize the sections by moving the section 
headings into your desired sequence.

How well your draft text comes out will depend on how familiar you are with 
using the tool and how completely you've answered the Magic Writer's 
questions.    Also, don't forget that the Magic Writer doesn't make spelling 
corrections.    So you'll always need to proof-read and run the Spell Checker 
on your report after you've used the Magic Writer to generate an initial draft 
version.

See Magic Writer Menu for more information.

User's Tips:    Even if you're planning to write your book report from scratch, 
using the Basics section of the Magic Writer is a quick way to generate a 
formatted cover page.



        Magic Writer Menu

Use this toolbar option to use the Magic Writer's automated tools to get your 
book report started.    Simply click to see the list of pre-written book report 
sections and make your selection.

          

    A second pop-up will then prompt you to answer the questions that will be 
used to generate a draft report section.    The following is an example for one 
section:



          

Click now to see the Help for About the Magic Writer for more information.



Magic Writer Sections
Point and click to select the Magic Writer sections for this book report.    Any 
section that's marked with an "X" is selected.

When your selections are all made, click on "Edit Checked Sections" to start 
filling out the sections.    Or, if you've already recorded the necessary 
information, click on "Edit Checked Sections" if you want to make any 
changes.    In either case, you'll then want to click on Create Checked 
Sections.    (If you've already generated a report and are just making 
changes, delete all of the text from the Outline Box, first.)    In just a few 
seconds, the draft book report will be ready for your review.

You can use as many of the 17 sections as you'd like; but each section should
only be used one time per book report.

Tips:    Don't choose the Start Over option unless you want to delete all of 
your answers and start completely from scratch.    If all you want to do is to 
make a few changes and re-generate your report, follow the procedure 
described above.



Magic Writer Text Boxes
Type in your answer or passage, here, using standard Windows conventions.

Tips:    A yellow Hints box will appear as soon as you click on most text boxes.
Follow the lead provided in the Hint to make sure that you enter your text 
with the proper syntax, and you'll be able to minimize the amount of editing 
that your draft requires after it has been generated.



Magic Writer Selections
Click to choose one or more selections, as indicated.



Create Checked Sections
Click here when you're ready to generate a book report based on the 
information that you've selected and provided.

If all of your information is complete, the draft book report will be ready for 
your review in just a few seconds.    If any information is missing, you will be 
prompted to fill it in so that the draft can be completed.



Start Over
Click here if you want to start this book report over from scratch, including 
selecting new sections.    All of you section choices and information will be 
deleted, and you'll be ready to begin again.

WARNING:    Choosing this option will cause all of your information for this 
report to be deleted.    If you want to keep most of the information, click on 
Edit Checked Sections to cycle through the section pop-ups and make any 
necessary changes.    Then go to the Outline Box and delete the text of the 
report, click on the Magic Writer, and then click on "Create Checked 
Sections" to create a new draft text.



Edit Checked Sections
Click here to enter information, or modify information you've already 
entered, for the sections that you have checked.



        Print Ideas
Click here to print a copy of the selected idea.



        Export Ideas
Click here to create a text file from the selected idea.






